Answer Key o’

Data Storage and Memory

T=CH S=T GO (Pageno.7)
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‘®.BYTS QU=ST (Pageno. 11)

1. Digital Versatile or Video Disc (DVD)

2. Pen Drive
3. Random Access Memory (RAM)
4. Hard Disk
T=CH R=ADY
A. 1. (i) 2. (i) 3. (i) 4. (i)
1. Volatile 2. Permanent 3. Zettabyte 4. USB

1. A circular metallic disk covered with a magnetic coating, that is used for storing data, is
called a Magnetic disk.

2. Memory card is used to store data. It is very small in size usually 1-1.5 inches. These are used
in mobile phones and digital cameras.

3. A group of 4 bits is known as a nibble (half a byte). Other units for measuring the computer’s
memory are kilobyte, megabyte, gigabyte, etc.
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4. Secondary storage devices are categorised into three types:

a. Magnetic Disk: A circular metallic disk covered with a magnetic coating, that is used for
storing data, is callled a Magnetic disk. You can record and erase data on a magnetic disk
any number of times.

b. Optical Disc: An optical disc is an electronic data storage medium that can be written to
and read using a low-powered laser beam. The lifespan of an optical disc is longer than
a magnetic disk.

c. Flash Drive: The Flash Drive is a small portable data storage device integrated with a USB
(Universal Serial Bus) connector.

5. a. Data: A collection of raw, unorganized facts, figures, or symbols. It does not have meaning
on its own.

b. Information: When data is organized, arranged, and given meaning or context.

T=ECH TWIST=R

1. MEMORY CARD 2. HARD DISK 3. FLASH DRIVE 4. MAGNETIC DISK

Competency-based/Application-based questions

1. We can use memory card to increase our smart phone’s storage space.
2. She can choose pen drive or flash drive for smooth exchange of data.

Muction to Excel 2016

T=ECH S=T GO (Pageno. 14)

Do it yourself.

‘2. BYTZ QUEST (Page no. 20)
1. (¢) 2.(d) 3. (e) 4. (a) 5. (b)

T=CH READY

A. 1. (i) 2. (iii) 3.(i) 4. (iv) 5. (iv)
B. 1. Name box 2. Title 3. Quick Access Toolbar

4. Formula 5. Worksheet
C. 1T 2.T 3.F 4. F 5.F
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. The row heading is the gray coloured number (1,2,3...etc) located in front of each row

in the worksheet.

. Ribbonis like a strip that has various tabs such as Home, Insert, Page, Layout, Formulas

and Data.

. The currently selected cell that appears highlighted with green border is an active cell.

4. While working in Excel, the following types of data can be entered:

A. L

* Numbers include the digits (0-9) and their various combinations. All types of
calculations can be done on numbers.

* Text: Text includes the collection of letters, numbers, and special characters. No
mathematical calculation can be performed on text.

. To enter data, follow the given steps:

Step 1: Click on the cell where you want to enter the data and start typing.
Step 2: To move down one cell, press the Enter key.

Repeat Steps 1 and 2 until you finish entering all your data.

. Contiguous Cell Range is a collection of cells that are adjacent to or next to one another.

A colon () is used for specifying this cell range, for example, A1:A6.

Non-contiguous Cell Range is a collection of cells that are not adjacent to one another. A
comma (,) is used for specifying this cell range, for example, A1, B2, C3.

. To create a new workbook in Excel, follow the given steps:

Step 1: Click on File tab.
Step 2: Click on the New option.
Step 3: Click on Blank workbook.

A new workbook will be created.

TECH TWIST=ER

D3 2.D5 3.E4 4.C4 5.B4 6. G4

B. Click on the File tab.
Click on Browse option.
Click on Save or Save As option.

Type a name for your file in the File name box.
(6] Click on the Save button.

Select the location where you want to save your workbook.
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Competency-based/Application-based questions

1. To save a workbook, follow the given steps:
Step 1: Click on the File tab.
Step 2: Click on Save or Save As option.
Step 3: Click on Browse option.
Step 4: Select the location where you want to save your workbook.
Step 5: Type a name for your file in the File name box.
Step 6: Click on the Save button.
2. To fill the time-table, follow the given steps:
Step 1: Click on the cell where you want to enter the data and start typing.
Step 2: To move down one cell, press the Enter key.
Repeat Steps 1 and 2 until you finish entering all your data.

mMon PowerPoint 2016

T=CH S=T GO (Page no. 27)
LT 2.7 3.7 4.F

‘©. BYTZ QU=ST (Page no. 32)

1. Align Left 2. Align Right 3. Center 4. Justify

‘2. BYTZ QU=ST (Page no. 40)

1. Pictures 2. Online Pictures 3. Shapes 4. SmartArt

T=CH READY

A. 1 (i) 2. (iii) 3. (iii) 4. (iv)
B. 1.slide 2. Design 3. Format 4. Justify
C. 1.(d) 2.(c) 3.(b) 4.(a)
D. 1. The Slide Show tab will let you set up how your show will progress.
2. The four types of alignment are Align Left, Align Right, Center and Justify.
3. To insert Online pictures in the document, follow the given steps:
Step 1: Click on the Insert tab.
Step 2: Click on the Online Pictures option.
Step 3: Type a word in Bing Image Search box.
P9
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Step 4: Select the picture, you want to insert.
Step 5: Click on the Insert button.
4. To insert shapes on the slide, follow the given steps:
Step 1: Click on Insert tab.
Step 2: Click on Shapes command in the Illustration group.
Step 3: Choose a desired shape from the drop down menu.

The selected shape will be inserted on the slide.

1. SLIDE 2. PRESENTATION 3. BACKGROUND 4. PLACEHOLDER
5. SMARTART

Competency-based/Application-based questions

1. Rohit can add pictures by using Picture command and Online Pictures command from Insert tab.
He can also use placeholder to insert pictures.

2. She can add themes from the Design tab to make slides look more colourful and attractive.

Periodic Assessment 1
(Based on chapters 1 to 3)

A. 1. Read Only Memory (ROM) 2. Hard Disk 3. Random Access Memory (RAM)
4. Blu-Ray Disc 5. Pen Drive 6. Memory Card

B. 1. Themes 2. Justify 3. Pictures
4. WordArt 5. Placeholder

C.

‘ Title Bar \

Quick Access Toolbar

Ribbon

Formula bar

; y

Worksheet
Tabs

Status bar \
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T=CH S=T GO (Page no.45)

1. Search information ‘ 2. Take a bath

3. Find a recipe ‘ 4. Send an email

5. Download an image ‘ 6. Pack your bag

7. Do shopping ‘ 8. Online communication

2. BYTZ QU=ST (Page no. 49)

1. Advanced Research Projects Agency

. Advanced Research Projects Agency Network

. Transmission Control Protocol

. Internet Protocol

. World Wide Web

. Hypertext Transfer Protocol

. National Center for Supercomputing Applications

0 N O U D WwN

. Uniform Resource Locator

T=ECH R=EADY

A.  1.() 2. (i) 3. (iii) 4. (iii) 5. (ii)
B. 1.Bcc 2.To 3.Cc 4. Attachment

C. 1F 2.T 3.F 4.F 5.F
D. 1

pages.

NN

6. (ii)
5. Sent

. A Web server is an Internet host computer that often stores thousands of individual Web

2. Emoticons are used to represent the facial expressions. They help in telling your mood to

others as well as save typing time.

3. Yes, we can send a video file as attachment in an e-mail through “attach files’ option.

4. The New Message window has many fields:

* To: In this field, type your friend’'s e-mail address. You can enter more than one address

by pressing " after each e-mail address.

e Cc: Cc stands for carbon copy. It is marked to the e-mail address who is to be informed

that an e-mail has been sent to the person marked in To field.

5. Logging In or login is the process of accessing your e-mail account by providing the user

name and password.
P
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6. URL stands for Uniform Resource Locator. It helps us navigate the Web. We can specify a
URL in several ways, but two methods are commonly used:

(i) Using Address Bar:
Step 1: Type the URL in the browser's Address bar.
Step 2: Press the Enter key from the keyboard.
(i) Using Hyperlink:
A hyperlink is simply a part of the Web page that is linked to a URL. A hyperlink can

appear as text, an image, or a navigational tool such as a button or an arrow. You

can click a hyperlink and jump from your present location to the URL specified by the
hyperlink.

1.Cc 2.To 3. Subject 4. Bcc

Competency-based/Application-based questions

1. By clicking on the Attach files button in the New Message window.

2. Sushant should write Ajay's e-mail in ‘To' and others’ e-mail addresses in ‘Bcc’.

T=CH S=T GO (Pageno.61)

Do it yourself.

‘2. COD= QU=ST (Page no.63)

1. No Parking 2.Veg and Non-Veg 3. Wheelchair 4. Zebra Crossing
5. No U-Turn 6. Hospital

‘2. COD= QU=EST (Page no. 64)

4%#32
T=ECH READY
A 1) 2. (iii) 3.(v)
B. LT 2.F 3.F
C.

1. Data refers to the raw input. When this data is processed, the outcome received is known
as information.

P=q
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2. We can represent information in the following ways:
a. In the form of tables, for example, class timetable.
b. In the form of pictures, drawing and so on.
¢. In the form of maps.
d. In the form of pictograms, for example, road signs.

T=ECH TWISTER

A. (i)
B. (iii)

Competency-based/Application-based questions

1. He can sort his things.

2. By using Coded data.

Periodic Assessment 2
(Based on chapters 4 & 5)

A. 1. Angry 2. Sleepy 3. Crying 4. Embarrassed
5. Surprised 6. Very Happy 7. No Expression 8. Sad
B. 1. Itis the folder where all e-mails that you have received from others are stored.
2. It is the folder where all e-mails that you send to others are stored.
3. It is the folder where all outgoing e-mails are temporarily stored.
4. It is the folder where all unwanted incoming e-mails are stored so that they stays out of the
inbox folder.
5. It is the folder where all deleted e-mails are usually stored for a defined time period.
C. 1 Sorting 2. Information 3. Website 4. Encoding
5. Decoding
D. 1.Laughing Out Loud 2. By The Way 3. As Soon As Possible
4. Forever 5. Frequently Asked Questions
Test Sheet 1
(Based on chapters 1 to 5)
A 1.(3) 2. (iv) 3. (iii) 4. (ii) 5. (i)
6. (iii) 7. (iv)
B. 1. Volatile 2. Zettabyte 3. Title 4. Placeholder 5.Cc
P9
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cC 1T 2.T 3.F 4. F 5F
D. 1.(d) 2.(c) 3. (b) 4. (a)

E. 1. a. Data:A collection of raw, unorganized facts, figures, or symbols. It does not have meaning
on its own.

b. Information: When data is organized, arranged, and given meaning or context.
2. While working in Excel, the following types of data can be entered:

* Numbers: Numbers include the digits (0 -9) and their various combinations. All types of
calculations can be done on numbers.

* Text: Text includes the collection of letters, numbers, and special characters. No
mathematical calculation can be performed on text.

3. To insert Online pictures in the document, follow these steps:
Step 1: Click on the Insert tab.
Step 2: Click on the Online Pictures option.
Step 3: Type a word in Bing Image Search box.
Step 4: Select the picture, you want to insert.
Step 5: Click on the Insert button.
4. E-mail has various advantages, some of them are:
* An e-mail can be sent to many people at a time.
* An e-mail can be easily forwarded to anyone without typing it again.
* Sending an e-mail is fast in comparison to traditional mails.
5. We can represent information in the following ways:
a. In the form of tables, for example, class timetable.
b. In the form of pictures, drawing and so on.
c. In the form of maps.

d. In the form of pictograms, for example, road signs.

mCLating Shapes in Scratch

T=CH S=T GO (Page no. 70)

1. Hat block 2. Stack block 3. Reporter block 4. Boolean block 5. C-block
‘2. COD= QU=ST (Page no. 74)

1. Heptagon 2. Triangle 3. Pentagon 4. Nonagon 5. Hexagon

6. Octagon
=
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T=CH R=EADY
1. (i) 2. (ii) 3.(0)
1. Polygon 2.360 3.Go 4. Hexagon
1F 2.F 3T 4.7

1. Pen block used to draw a trail as the Sprite moves on the stage.

°onNnpwzp

2. One of the thumb rule to draw polygons in Scratch is:
* You must know the number of sides in the shape. This is the value to be given in repeat
block. For example, you give repeat 3 to draw a triangle and 4 to draw a square.
3. To add Pen block, follow the given steps:
Step 1: Click on the Add Extension button at the bottom left corner of the Code tab.
Step 2: Click on Pen option. The Pen blocks are added to the Code tab.

1. Sides : 0, Degree : 360 2. Sides : 3, Degree : 120
3. Sides : 4, Degree : 90 4. Sides : 4, Degree : 90
5. Sides : 5, Degree : 72 6. Sides : 6, Degree : 60

Competency-based/Application-based questions

1. Pen blocks
2. Repeat 3, Move 100 Steps, Turn 120 degrees

EMCECI Blocks & Game Creation

T=CH S=T GO (Page no. 80)

N

‘2. COD= QU=ST (Page no. 83)
1. ask and wait block

2. key pressed?

£

1 DigiCode Al (Ver. 2.1)-V (Answer Key) <<<<<<<<<<<<<<<

IMPRINT 1



3. The blocks that end scripts are known as CAP blocks.

4. C blocks are loop blocks to check if a condition is true in the blocks within the loop.

‘%, COD= QU=ST (Page no. 88)

1. If a variable is created, to be used and modified by all the sprites, then it is known as a global

variable.

2.If a variable is created to be used and modified by a single sprite only, then it is known as a

local variable.

T=CH READY

A.
B.
C.
D.

C and Cap.

1. (iii) 2.(3) 3.() 4. (ii)
1. script 2. touching color 3. local 4. ask and wait

LT 2.T 3.F 4. F

1. Scratch blocks can be divided into six types of shapes. They are: Hat, Stack, Boolean, Reporter,

2. The sensing blocks in Scratch sense the input from the keyboard or the mouse at the time

of execution of a script.

3. There are two types of variables. They are: Global Variables and Local Variables.

4. Scratch has two conditional blocks. They are:

¢ If,then block: In this block if the condition is true, the blocks inside conditional block
will run. If the condition is false, the blocks inside conditional block will not run. Only the

blocks outside the conditional block will run.

¢ If then,..else block: In this block if the condition is true, the blocks inside then condition

will run. If the condition is false, the blocks inside else condition will run.

TECH TWISTER

A. 1.The sprite will rotate 360 times. Each time it will turn at 30 degree and move 10 steps.

2. The sprite will turn 15 degrees. It will keep on moving till user stops the program.

B. Doityourself.

Competency-based/Application-based questions

1. ask and wait block

2. touching mouse-pointer ? block

PO o et
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C.

1. C-Blocks, Control blocks

Periodic Assessment 3
(Based on chapters 6 & 7)

2. Hat Blocks, Event Blocks

3. Control Blocks, CAP Blocks

1. Hat blocks always comes on the top of a script.

2. A Script is made up of number of blocks.

3. In scratch, a program is called a Script.

\

P

5
V

T=CH S=T GO (Page no.93)

1. Siri

2. Sophia 3. ASIMO

‘. Ai QUEST (Page no. 98)

1. ChatGPT

A. 1. (i)

B. 1 Alexa

C. LF

D. 1.Swiggy, Ola

A.

-
N

14

2. Microsoft Copilot 3. Google Maps 4. Swiggy
T=CH R=EADY

2. (i) 3. (ii) 4. (i) 5. (i)

2. Students 3. Google Assistant 4. Netflix

2.F 3T 4.7

5. Netflix

2. Netflix uses Al to understand the user’s preferences and suggests content according to the

users’ liking.

3. Students can use camera to take pictures and Socratic provides visual explanation for students’

learning.

1. YouTube

| DigiCode Al (Ver. 2.1)-V (Answer Key)

2. Netflix 3. ChatGPT 4. Google Assistant
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Competency-based/Application-based questions

1. ELSA Speak 2. Google Maps

BIEA ending Robots

T=ECH S=T GO (Pageno. 103)

1. Driverless Car 2. Smartphone 3. Smartwatch

‘% Ai QUEST  (Page no. 110)

Do it yourself.

T=CH R=ADY

A. 1) 2. (iii) 3. (iii) 4. (i) 5. (ii)
1. Robotics 2. RoboThespian 3. T-HR3 4. Dash & Dot
5. Paro

C. 1F 2.7 3.7 4. F

D. 1.Robots are automatically operated machines that work in place of humans. It is not necessary
that they look like humans by appearance or perform exactly like humans.

2. Z-Machines is a music-band developed in Japan. It has a guitarist with 78 fingers and a
drummer with 22 arms.

3.a. Nao b. Leka c. RoboThespian
1. Sophia 2. Leka 3. Digit 4. RoboThespian
5. Paro 6. Root

Competency-based/Application-based questions

1. Robear 2. Root
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T=CH S=T GO (Page no.115)

Do it yourself.

. Al QU=ST (Page no.119)

Do it yourself.

T=ECH READY

A. 1. (iv) 2. (iv) 3.() 4. (ii)

B. 1.Bot 2. Replika 3. Mondly 4. Andy chatbot

C. LF 2.F 3T 4.7

D. 1.(d) 2.(0) 3. (b) 4. (a)

E. 1. A Chabot, also known as a bot, is a computer program that allows humans to interact with

computing devices through voice, text, gesture, and touch. Mitsuku is one of the famous
chatbot.

2. The uses of Mitsuku are as follows:
e Chat
e Hear stories or poems or jokes
* Play games
* Surf webpages and pictures

3. Name of the Domino’s chatbot is Dom. Dom chatbot lets you order your favourite pizza
with a single word.

Do it yourself.

Competency-based/Application-based questions

1. Andy chatbot 2. Dom chatbot

14, DigiCode Al (Ver. 2.1)-V (Answer Key) <<<<<<<<<<<<<<<<
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Periodic Assessment 4
(Based on chapters 8 to 10)

A. 1. Robear 2.Z-Machines 3. Dash & Dot 4. Zenbo
1. Alexa 2. Siri 3. Google Gemini 4. Google Assistant
5. Swiggy
C. 1. MITSUKU 2. REPLIKA 3. ANDY 4. MONDLY 5. DOM
Test Sheet 2
(Based on chapters 6 to 10)
A. 1.() 2. (i) 3. (i) 4. (i) 5. (iii)
6. (ii) 7. (iv)
B. 1l askandwait 2.Go 3. Google Assistant 4. Mondly
5. RoboThespian
C 1T 2.F 3T 4.F 5T
1. (d) 2.(0) 3. (b) 4. (a)
E. 1. Scratch has two conditional blocks. They are:
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¢ If,then block: In this block if the condition is true, the blocks inside conditional block
will run. If the condition is false, the blocks inside conditional block will not run. Only the
blocks outside the conditional block will run.

¢ If,then,..else block: In this block if the condition is true, the blocks inside then condition
will run. If the condition is false, the blocks inside else condition will run.

. Polygons are 2D shapes with 3 or more straight lines and angles. Examples are Triangle,

Square and Rectangle.

. Students can use camera to take pictures and Socratic provides visual explanation for students’

learning.

. The uses of Mitsuku are as follows:

* Chat
* Hear stories or poems or jokes
* Play games

* Surf webpages and pictures

. (a) Leka

(b) Nao
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